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Preface

Purpose
The soft and hardware components of Windows Automation Center (WinAC)
enables you to combine data processing, controlling, visualization, and
communication on your PC (PC--based Control). The WinAC product is available in
three different forms:

S WinAC Basis with SoftPLC

S WinAC Pro with SlotPLC-Modules CPU 416-2 DP ISA

This manual provides you with an overview of the individual components of the
WinAC products.

Audience
This manual is intended for engineers, programmers, and maintenance personnel
who have a general knowledge of programmable logic controllers.

Scope and Usage of the Manual
An overview is provided of the features and the operation of version 3.0 of the
WinAC Pro software. This includes:

S An overview of the components of the WinAC Pro standard package
S Instructions for installing the WinAC Pro software

Other Manuals
For additional information, refer to the following manuals:

Title Contents

WinAC Controlling with
CPU 416--2 DP ISA

This manual describes the operations, functions, and technical
data for the CPU 416-2 DP ISA.

WinAC Computing
User Manual

This manual provides basic information about the performance
characteristics and operation of the WinAC software.

You can also find information about the components of the WinAC Pro in the online
help for the software.
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Validity
The manual contains information on WinAC Pro, as valid at the time of publication.
We reserve the right to enclose additional information in the form of a Product
Information leaflet.

Additional Assistance
If you have any questions not answered in this or one of the other STEP 7
manuals, if you need information on ordering additional documentation or
equipment, or if you need information on training, please contact your Siemens
distributor or sales office.

SIMATIC Customer Support Hotline
Open round the clock, world--wide:

Johnson City

Nuremberg

Singapore

Simatic Hotline

Nuremberg
SIMATIC BASIC Hotline

Johnson City
SIMATIC BASIC Hotline

Singapore
SIMATIC BASIC Hotline

Local time:Mo.-Fr. 7:00 to 17:00
Phone: +49 (911) 895-7000
Fax: +49 (911) 895-7002
E-Mail: simatic.support@

nbgm.siemens.de
GMT: +1:00

Local time:Mo.-Fr. 8:00 to 17:00
Phone: +1 423 461-2522
Fax: +1 423 461-2231
E-Mail: simatic.hotline@

sea.siemens.com
GMT: --5:00

Local time:Mo.-Fr. 8:30 to 17:30
Phone: +65 740-7000
Fax: +65 740-7001
E-Mail: simatic@

singnet.com.sg
GMT: +8:00

Nuremberg
SIMATIC Authorization Hotline

Nuremberg
SIMATIC Premium Hotline

Local Time: Mo.-Fr. 7:00 to 17:00
Phone: +49 (911) 895-7200
Fax: +49 (911) 895-7202
E-Mail: authorization@

nbgm.siemens.de
GMT: +01:00

(Calls charged, only with
SIMATIC Card)
Time: Mo.-Fr. 0:00 to 24:00
Phone: +49 (911) 895-7777
Fax: +49 (911) 895-7001
GMT: +01:00

The languages spoken by the Simatic Hotlines are generally German and English. In addition, the authorization hotline
speaks French, Italian and Spanish.
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SIMATIC Customer Support Online Services
The SIMATIC Customer Support team offers you substantial additional information
about SIMATIC products via its online services:

S General current information can be obtained:
-- on the Internet under http://www.ad.siemens.de/simatic-cs

S Current product information leaflets and downloads which you may find useful
are available:

-- on the Internet under http://www.ad.siemens.de/support/html_00/
-- via the Bulletin Board System (BBS) in Nuremberg (SIMATIC Customer

Support Mailbox) under the number +49 (911) 895-7100.

To access the mailbox, use a modem with up to V.34 (28.8 Kbps) with
parameters set as follows: 8, N, 1, ANSI; or dial in via ISDN (x.75, 64 Kbps).
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Product Overview and Installation

Overview
The WinAC Pro package consists of the following components:

S The SLOT PLC ”CPU 416-2 DP ISA”, the most powerful S7-400 CPU, for the
WinAC Controlling components.

S The router for the communication of the CPU 416-2 DP ISA over a
SIMATIC NET CP (Industrial-Ethernet or PROFIBUS) or a network card.

S An operator panel for the CPU 416-2 DP ISA, displayed on a monitor.

S The WinAC Computing software provides ActiveX controls, which you can
customize for the visualization of your process. WinAC Computing lets you use
any mix of S7 and third-party ActiveX controls not only to view, but also to
modify, process data.

S The WinAC Tool Manager can be used with your applications. It is a toolbar in
which you can arrange all the applications that you want to use while working
with your process data.

For instance, if you plan to use Visual Basic with WinAC, or want to put process
data into an Microsoft Excel spreadsheet, you can insert shortcuts to those items
on the Tool Manager. The Tool Manager is especially convenient for users who do
not have a computer mouse, since all of its functions can be accessed by
keystrokes from one central location.

Chapter Overview

Section Description Page

1.1 Communications Possibilities CPU 416-2 DP ISA 1-2

1.2 Controlling Your Process with CPU 416-2 DP ISA 1-4

1.3 WinAC Computing Provides Access to the Process Data 1-5

1.4 Tool Manager Provides Shortcuts to Your Programs 1-6

1.5 Time synchronization 1-9

1.6 Router for CPU 416-2 DP ISA Communication 1-10

1.7 Installation Overview 1-11

1.8 Installing and Uninstalling the WinAC Pro Software 1-13

1
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1.1 Communications Possibilities CPU 416-2 DP ISA

PC

CPU 416-2 DP ISA

MPI PROFIBUS DP

Communication CP
Industrial Ethernernet or
PROFIBUS-Subnet

MPI-Subnet

PROFIBUS-DP

Industrial Ethernet / PROFIBUS-Subnet

PG
OP
OS

AS MPI PROFIBUS DP

PC
CPU 416-2 DP ISA

Router/
timer synchronization

CP MPI PROFIBUS DP

PC

CPU 416-2 DP ISA

PG
OP
OS

Slave

AS

PG
OP
OS

SIMATIC
Manager

WinCC

Router/timer synchronization

Figure 1-1 Communication possibilities with the CPU 416C2 DP ISA

Figure 1-1 shows which communication possibilities you have with the CPU 416-2.
The CPU 416-2 DP ISA has an integrated MPI and PROFIBUS-DP interface.
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If you wish to communicate with an industrial ethernet or PROFIBUS subnet, an
additional communications module (CP) must be installed in your PC.

The possible communications between stations are:

1. From the available CPU 416-2 DP ISA stations

-- all PLCs on local MPI subnets

-- all slaves on local PROFIBUS DP
-- all PLCs on Industrial Ethernet PROFIBUS Subnets

2. Stations available to the CPU 416-2 DP ISA:

-- all programming devices / OS / OP on all subnets

-- local WinCC
-- local STEP 7

3. Stations available to WinCC or STEP 7:

-- local CPU 416-2 DP ISA
-- all PLCs on Industrial Ethernet/PROFIBUS Subnets

Note
If the SIMATIC Manager (STEP 7) is installed on the same PC as the
CPU 416-2 DP ISA, it is not possible to use the CPU 416-2 DP ISA and Industrial
Eithernet / PROFIBUS subnet connected CPUs at the same time.

With ”setprogramming device / PC interface”you must parameterize the
corres-ponding S7ONLINE (STEP 7) access point.
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1.2 Controlling Your Process with CPU 416-2 DP ISA

CPU 416-2 DP ISA offers an effective hardware solution for your automation
projects (see Figure 1-2). The CPU 416-2 DP ISA connects a PC-based controller
to the distributed (remote) I/O via a PROFIBUS DP network.

CPU 416C2 DP ISA

Distributed I/O

Figure 1-2 Using the CPU 416-2 DP ISA in WinAC Pro

As shown in Figure 1-3, you can use the WinAC Computing software to provide
access to the process data. You can also use the standard SIMATIC products with
the CPU 416-2 DP ISA, such as STEP 7 and WinCC.

PC with the
SLOT PLC
module

STEP 7 WinCC

Optional SIMATIC products

WinAC
Computing

Third-party
products

Figure 1-3 Components of WinAC Pro
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1.3 WinAC Computing Provides Access to the Process Data

As shown in Figure 1-4, the WinAC Computing software allows you to access the
SLOT PLC in order to monitor and modify the process data.

WinAC Computing provides several methods for accessing the process data:

S Via standard ActiveX controls (OCX) that access the process data

S Via an OPC server (OLE for Process Control) server that allows any OPC client
application to access data in the control device

Note
The OPC server is based on the OLE/COM technology from Microsoft. For more
information about OPC, refer to the OPC specification: OLE for Process Control
Data Access Standard, version 1.0A from the OPC Foundation
(http://www.opcfoundation.org/).

WinAC Computing does not provide the OPC client application.

WinAC Computing

OFF

0

CPU 416-2 DP ISA

Figure 1-4 Accessing the Process Data with WinAC Computing
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1.4 Tool Manager Provides Shortcuts to Your Programs

The WinAC Tool Manager provides quick access to the programs that you use with
the WinAC products. Figure 1-5 shows the Tool Manager and its shortcut icon. You
can configure the Tool Manager yourself: you can insert a shortcut icon for any of
your programs into the tray. You can then access that program from the Tool
Manager.

You can change the size of the Tool Manager. As shown in Figure 1-6, you can use
a menu to configure the Tool Manager. You can also choose to display the Tool
Manager either horizontally or vertically.

Tool ManagerShortcut icon

S7 logo ToolbarWinAC
Tool Manager

Figure 1-5 WinAC Tool Manager

Using the Tool Manager without a Mouse
You can also use the Tool Manager without a mouse:

S If the Tool Manager is running, pressing the ALT + Tab keys displays the Tool
Manager.

S Pressing the F1 key displays the online help for the Tool Manager.

S Pressing the Tab key changes the focus between the S7 logo and the shortcut
icons.

S Pressing the Return key when a shortcut icon is highlighted starts the
associated program.

Refer to the online help for more information about using the keyboard with the
Tool Manager.
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Inserting Icons into the Tool Manager
Use the following procedure to insert icons into the Tool Manager:

1. Display the Tool Manager by double-clicking the shortcut icon for the Tool
Manager.

2. Display the menu options for the Tool Manager by clicking the right button of the
mouse. See Figure 1-6.

3. Select the Insert command from the menu to display a browser for selecting
shortcut icons.

4. Select the icons from the browser and confirm.

You can also drag and drop shortcut icons into the Tool Manager using the mouse.
Refer to the online help for more information about using the Tool Manager.

Figure 1-6 Inserting Icons into the WinAC Tool Manager
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Customizing the Display Options for the Tool Manager
You can use the mouse to adjust the size of the Tool Manager. You can also use
the options menu (shown in Figure 1-6) to further customize the Tool Manager:

S With the menu command Restore the Toolbar with icons is displayed.
S With the menu command Icon only the S7 Tool Manager logo is displayed.

S By selecting either the Horizontal or Vertical menu command, you can choose
the orientation for the Tool Manager.

S With the menu command Select Language you set the installed language for
the Tool Manager. To change the software language settings, you have to
restart the program.

S By selecting the Always On Top menu command, you can choose to have the
Tool Manager always displayed (on top of the application, instead of being
hidden behind).

S By selecting the Full Path Name menu command, you can display the path.

S name for the shortcut icons.

S Select the menu command Fit to screen, to automatically adjust the size of the
Tool Manager to the width and height of the screen.

S By selecting the Auto Size menu command, you can automatically size the
Tool Manager to the width (or height) of the screen.

S With the menu command Rebuild Tool Manager the Toolbar is displayed in
the optimal height or width.

S Pressing the F1 key or selecting the Help menu command displays the online
help for the Tool Manager.

S With the menu command Exit you close the program.
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1.5 Time Synchronization

The CPU 416-2 DP ISA can, together with other stations (e.g. S7 Components),
be synchronized by a central time sender.

The time synchronization service in the PC periodically supplies the CPU with the
current date and time. The time sender sets the time in cyclical periods and
provides it to the Industrial Ethernet/PROFIBUS (IE/PB). For Industrial Ethernet
only ISO Protocol is supported. This synchronizes the CP in the PC.

Time synchronization Software Components

IE CP bzw PB CP

PLC

IE/PB

PC

CPU 416-2 DP ISA Hardware Components

OP/OS S7-StationTime
sender

Figure 1-7 Time Synchronization

Note

The timer synchronization is only designed for specific communication modules
(CPs). More informtion is available in the product information.
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1.6 Router for CPU 416-2 DP ISA Communication

So that stations (such as programming devices, OP, OS, S7 automation systems)
connected to a SIMATIC NET (Industrial Ethernet/PROFIBUS (IE/PB)) can
communicate with the CPU 416-2 DP ISA, a router must be installed in the
programming device / PC and the access points have to be configured. Data
transfer is possible in both directions. For Industrial Eithernet the protocol ISO and
TCP/IP is supported.

Router Software Components

IE CP or PB CP

PG

IE/PB

PC

CPU 416-2 DP ISA Hardware Components

OP/OS S7-Station

Figure 1-8 Communication via the Router
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1.7 Installation Overview

The WinAC software provides a setup program that installs the
CPU 416-2 DP ISA, along with the other software components (operator panel,
WinAC Computing, Tool Manager, Router, and Time Synchronization).

System Requirements
To run the components of WinAC Pro, it is recommended that your computer meet
the following criteria:

S A personal computer (PC) with the following:

-- Pentium processor running at 166 MHz or faster

-- 32 Mbytes RAM
-- Microsoft Windows NT version 4.0, since Servicepack 3

S A color monitor, keyboard, and mouse (or other pointing device) that are
supported by Microsoft Windows NT

S A hard drive with 50 Mbytes of free space
S At least 25 Mbyte free memory capacity on drive C for the Setup program

(Setup files are deleted when the installation is complete.)

S 2 ISA slots for 3/4 length cards at standard intervals.
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Installing the Components of WinAC
Section 1.8 describes how to install the WinAC software.

Figure 1-9 shows the dialog box in which you can choose which components to
install. Select the components that you want to install. All the components are
installed in the same directory.

Figure 1-9 Installing the Components of WinAC Pro

Note
If the components CPU 416-2 DP ISA Router or PLC Time Sync are installed, the
component WinAC Computing must be installed as well.
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1.8 Installing and Uninstalling the WinAC Pro Software

The WinAC Pro software includes a Setup program which carries out the
installation automatically. The screen prompts guide you step by step through the
installation procedure.

Starting the Installation Program
The Setup program guides you step by step through the installation process. You
can switch to the next step or to the previous step from any position. To start the
installation program, proceed as follows:

1. Start the dialog box for installing software under Windows NT by double-clicking
the "Add/Remove Programs" icon in the Control Panel.

2. Click "Install..."

3. Insert the CD-ROM and click "Next." Windows NT searches automatically for
the installation program Setup.exe.

4. Follow step by step the instructions displayed by the installation program.

Once the installation has been completed successfully, a message to that effect is
displayed on the screen.

If a Version of WinAC Basis/WinAC Pro Has Already Been Installed
Your software will be better organized if you uninstall any older versions before
installing the new version. Overwriting an old version with a new version has the
disadvantage that if you then uninstall, any remaining components of the old
version are not removed.

Note

WinAC Pro and WinAC Basis use the same software components for WinAC
Computing and the Tool Manager.

These sections may be updated if, for example, you have already installed WinAC
Basis.

Other information can be found in the current Readme files for the relevant software
components.
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Errors During Installation
The following errors may cause the installation to fail:

S Initialization error immediately after starting Setup: The Setup.exe program
was probably not started under Windows NT.

S Not enough memory: You need at least 50 Mbytes of free space on your hard
disk.

S Bad CD-ROM: Verify that the CD-ROM is bad, then call your local Siemens
representative.

S Operator error: Start the installation again and read the instructions carefully.

Uninstalling the WinACPro components
Proceed as follows to remove the WinAC Computing software from your computer:

1. Double-click the ”Add/Remove Programs”icon in the Control Panel.

2. Select one of the components of WinAC Pro to be uninstalled from the list of the
software installed. To uninstalled the software, click the ”Remove”button.

3. If the ”Remove Enable File”dialog boxes appear, click the “No”button if you are
unsure how to respond.

Note
Follow the information in the Readme files of the corresponding SW components.
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Getting Started

Chapter Overview

Section Description Page

2.1 Application Example: Communication via the Router 2-2

2.1.1 Creating a Project 2-3

2.1.2 Configuring the Access Points 2-11

2.1.3 Starting the Router 2-13

2.1.4 Communication 2-13

About This Getting Started Manual
In this manual, you will get to know the basics of WinAC Pro. We will show you the
most important screen dialog boxes and the procedures to follow using practical
exercises, which are structured so that you can start with almost any chapter.

Previous experience of working with the mouse, window handling, pull-down
menus, etc. would be useful, and you should preferably be familiar with the basic
principles of programmable logic control.

The STEP 7 training courses provide you with in-depth knowledge above and
beyond the contents of this Getting Started manual, teaching you how entire
automation solutions can be created with STEP 7.

Requirements for Working with the Getting Started Manual
In order to carry out the practical exercises for STEP 7 in this Getting Started
manual, you require the following:

S A Siemens programming device or a PC

S The STEP 7 software package and the authorization diskette

S A SIMATIC S7-400 programmable controller
Have fun and good luck!

SIEMENS AG

2
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2.1 Application Example: Communication via the Router

In the example a PC workstation with WinAC Pro is to be connected with a
SIMATIC S7 400 station via Industrial Ethernet (IE).

Router Software components

CP 1413

Industrial Ethernet (IE)

PC

CPU 416-2 DP ISA Hardware components

S7 station

Figure 2-1 Communication via the Router
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2.1.1 Creating a Project

Procedure:

1. Create a project called ”Router”.
2. Insert 2 SIMATIC 400 stations by using

Insert > Station > SIMATIC 400 and call the PC station FI25 and the
SIMATIC S7-400 station S7-400.

Figure 2-2 Creating a Project
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Hardware Configuration of the PC Workstation FI25
Selecting the Rack

1. Select the station FI25.
2. Open the ”HW-Config”function by double-clicking on ”Hardware”.

3. Open the catalog and then select the directory ”SIMATIC PC Based Control”.

4. Double-click to select ”WinAC CPU 416-2 DP ISA”. The rack is included in the
configuration table.

5. Do not network the subnet for the DP master.

Note
During the selection take the current MLFB number into consideration.

Figure 2-3 Selecting the Rack
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Assigning the CP

1. Double-click to select the ”Industrial Ethernet Connection”. Slot 9 is assigned to
the Profibus connection.

2. Save the setting.

PC Link corresponds to the CP in the station (PC/FI25) which connects the
CPU 416-2 DP ISA to the network.

Note
During the selection take the current MLFB number into consideration.

Figure 2-4 Assigning a CP
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Hardware Configuration of the S7-400 Station
1. Select the components listed below and configure them as shown in Figure 2-5

Rack
Power supply
CPU 416-1
CP 443-1

2. Do not network the subnet for the CP 443-1.
3. Close by selecting ”Save”

Note
During the selection take the current MLFB number into consideration.

Figure 2-5 Hardware Assignment of the S7-400 Station
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Creating the Connection
MPI Connection

1. Select the ”Router”project.
2. Double-click to open MPI(1).

3. Double-click to select the CPU 416-2.

4. Open the properties dialog box and change the network name from ”MPI (0)”to
”MPI Network”and set the address to 2.

5. Double-click to select the CPU 416-1.

6. Open the properties dialog box and select the MPI network.

7. Set the address to 10.

Figure 2-6 MPI Connection
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Industrial Ethernet Connection

1. Select the ”Router”project.

2. Insert the Profibus subnet by selecting

Insert > Subnet > Industrial Ethernet and rename the Ethernet (1) to IE-Net.

3. Double-click to open the IE-Net.
4. Double-click to select the PC Link.

5. Open the properties dialog box and select the IE-Net.

6. Assign the address 0800060002.

7. Double-click to select the CP 443-1.
8. Open the properties dialog box and select the IE-Net.

9. Assign the address 0800060001.

10.Double-click to select the DP master.
11.Open the properties dialog box and select a new network. Assign the name

PB-CPU 416-2 and the address 2.

Figure 2-7 Bus Connection
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Configuring the Connection
A connection defines the communication relation between two users. The following
points are specified here:

-- The two communication participants
-- The type of connection (in this case the S7 connection)

-- Special properties which depend on the type of connection (for example
whether the connection is to remain established permanently or whether it is
to be connected and disconnected dynamically).

Proceed as follows in order to enter a connection:

1. Select the module CPU 416-2 DP ISA (connection table is visible).

2. Double-click in an empty line of the connection table or select the menu
command Insert > Connection... Result: The ”New Connection”dialog box is
opened.

Figure 2-8 Creating a Connection

3. In the fields ”Station”and ”Module”select the programmable module to which
the connection is to be made (called connection partner or also remote user).

4. Select the connection type (only S7 connection) in the ”Type”Field.

5. Activate the ”Show Properties Dialog Box”check box.

6. Confirm by clicking on ”OK”. The ”Properties Connection”dialog box is opened,
Figure 2-9.
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Figure 2-9 Connection Properties

7. Check the settings (interface and type) in Figure 2-9.

8. Confirm your entries by clicking on the ”OK”command button.

The first connection has now been created. The second connection is established
by the same procedure. Start at Point 1 with the CPU 416-1.

STEP 7 enters the connection in the connection table of the local user and assigns
the local ID and, if appropriate the partner ID, for this connection which you require
to program the communication function block (value for the block parameter ”ID”).

The configuration process in the ”Router”project is completed with the specified
settings. Download the data to the respective station.
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2.1.2 Configuring the Access Points

1. Open the Router control panel in the system bar as follows:
Start > SIMATIC > PC Based Control > CPU 416-2 DP ISA Router
Configuration.

2. Click on the ”Set PG/PC Interface”command button in the ”Assign”tab card.

Procedure for setting the access points:

Figure 2-10 Setting the Programming Device/Personal Computer Interface

1. In the ”Application access point”field select the element ”CPU416-2 DP ISA
Net0”.

2. In the ”Used interface configuration”field select the CPU ”CPU416-2 DP ISA
Card (local)”.

Use the following steps to select the communication partner:

3. In the ”Application access point”field select the element ”CPU416-2 DP ISA
Net1”.

4. In the ”Used interface configuration”field select the CP ”CP1413”.

5. Under ”Properties”carry out the settings for the corresponding user CP as
shown in Figure 2-11.
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Note
the station addresses and the network-specific settings must be identical with the
settings in the S7 project.

Figure 2-11 Setting the CP Properties

6. Cancel the Program ”Set PG/PC Interface”.
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2.1.3 Starting the Router

A data exchange can be carried out with the router after you have configured the
hardware, set the connection for the project and configured the access points.

1. Change to the tab ”General”
2. Start the router by clicking on ”Start”.

The set connections are now displayed in the ”Connections”router tab card.

2.1.4 Communication

Include the corresponding communication blocks (for example Put/Get) into your
application program.
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